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Introduction

This Codebook and Users’ Guide provides a tool for programmers and analysts to assist them in
creating cross-tabulations and basic statistical estimates from the 2004 Adult Health Care Survey of
DoD Beneficiaries (HCSDB). Itis intended to facilitate users in creating tables and generating analyses
above and beyond those associated with this project.

This version of the Codebook and User’s Guide describes the second quarter data set. It presents the
frequency counts of all variables from the second quarter survey.

This chapter explains how to use this guide, reviews the survey, briefly describes the sample design,
and concludes with a list of other documents on the HCSDB data that may be useful for policymakers,
administrators, and other users.

How to Use This Guide

Chapter 2 describes the database conventions and types of variables in the database. Furthermore, it
explains the relationship between the raw survey data and the cleaned and constructed variables
preferred for data analyses.

Chapter 3 provides table-making instructions in both SAS and SPSS and clearly demonstrates the
basic computer programming code necessary to tabulate the data in SAS and the interactive steps
involved in generating tables in SPSS (either statistical package may be used). While we assume that
most users have some knowledge of computer systems and statistical processing, examples of how to
create tables and the resulting output are provided in order to simplify the process of data tabulation.
Due to the complexity of the sample design, we suggest that users interested in measuring the
precision of their results use a statistical package capable of calculating standard errors for survey
estimates, such as SUDAAN™ or WesVar PC®. Sample programming code is included to estimate
standard errors using appropriate methods to accommodate the complex sample design.

The codebook is presented in Chapter 4, where we describe each variable in the database, including a
list of all possible values of the variable, weighted and unweighted frequency counts and percent
occurrences for each value, and the values’ interpretation or formatting. The codebook helps users
assess the availability of certain measures, specify variables of interest, and identify all possible values
of avariable. The variables are listed in the order of their position on the data file, and they are grouped
by source as follows:

= Sampling variables used to place beneficiaries in the appropriate strata

= Information from the Defense Enrollment Eligibility Reporting System (DEERS) at the time of
sampling

= Questionnaire responses: cleaned and recoded
= Variables created during the fielding of the survey
» Coding Scheme flags and missing value counts

= Constructed variables for analysis

»  Weights
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In addition, users may refer to the Table of Variables, which follows directly after the Table of Contents,
for an alphabetical quick-reference list intended to assist users in locating each variable.

What is the HCSDB?

The HCSDB is a health care survey of active duty military personnel, retirees, and their adult family
members. It is comprised of an adult and a child survey, both fielded to a representative sample of
beneficiaries. The adult survey is fielded every quarter, whereas the child survey is fielded only in the
third quarter of each year. Results from each quarter are presented as a web-based report. The
survey is sponsored by the Assistant Secretary of Defense (Health Affairs) [OASD (HA)], under
authority of the National Defense Authorization Act for Fiscal Year 1993 (P.L. 102-484). The surveys
collect data on beneficiaries’ satisfaction with, and access to, health care; knowledge of the TRICARE
system; and use of preventive and other health care services.

Fielded annually from 1994 to 2000, the HCSDB now is fielded quarterly and consists of a fixed core
guestionnaire complemented by quarterly supplements intended to address topics of emerging interest.
Users should note that, prior to 2000, the title of the HCSDB corresponded to the reference year that
respondents were asked to think about when responding to questions. For example, although the
2000 HCSDB was fielded in 2001, beneficiaries responded to questions according to the reference
period 12 months prior. Under the current naming convention the survey title refers to the year the
questionnaires are fielded, so, for example, this year's survey is the 2004 HSCDB. Users should
further note that, due to this change, there is no survey with the title "2001" survey, even though the
questionnaire has been administered continuously throughout each quarter of 2001, 2002 and 2003.
The annotated questionnaire appears in Appendix A. A crosswalk between the 2004 questions and the
questions from the 1994-1995, 1996, 1997, 1998, 1999, 2000, 2002 and 2003 surveys appears as
Appendix B.

The HCSDB fixed questionnaire covers the following topics:

= Health Plan. This section collects data on TRICARE Prime enrollment and the use of
supplemental insurance and/or other private insurance.

= Your Personal Doctor or Nurse. In this section, respondents are asked about their relationship
with their personal doctor or nurse. They are asked to rate their personal doctor or nurse on a
scale from 0 to 10, where 0 is the lowest rating and 10 is the highest rating.

= Getting Health Care from a Specialist. This section collects information about respondents’
need for and access to care from specialists. Respondents rate the specialist that they see most
frequently on a scale from 0 to 10, where 0 is the lowest rating and 10 is the highest rating.

= Calling Doctors’ Offices. Questions in this section ask beneficiaries whether they were able to
access care and obtain information by telephone from their doctor’s office or clinic.

= Your Health Care in the Last 12 Months. This section collects information on where DoD
beneficiaries received the majority of their care in the past 12 months, that is, from a military or
civilian facility. It also covers topics such as the availability of providers and their staff, convenience,
and courtesy and respect shown by providers and their staff.

= Your Health Plan. This section is designed to measure beneficiaries’ satisfaction with their
primary health plan. Respondents are asked to rate their health plan on a scale of 0 to 10 where 0
is the lowest rating and 10 is the highest rating. TRICARE Prime enrollees are asked about their
satisfaction with Prime and about their likelihood of possibly disenrolling. Additionally, respondents
are asked questions about any problems they may have encountered with claims processing,
accessing and comprehending written materials, customer service, processing paperwork, and
resolving complaints.
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* Your Preventive Health Care. This section collects information on the use of preventive health
care services, including blood pressure readings, cholesterol screening, and flu shots. Allwomen
are asked about Pap smears; women that are or have been pregnant within the past 12 months
are questioned about prenatal care. Women age 40 and over are asked about mammography
and breast examination by a health care professional. Men are asked about prostate
examinations. All respondents are asked whether they smoke. Smokers are asked whether, and
how often, they have received smoking cessation counseling from a health care professional.

= About You. This section asks basic background and health status questions. Beneficiaries are
asked how they view their general health, as well as the number of days in the past month they
have felt their physical or mental health was not good. They are further asked to indicate how
many days they have experienced more specific physical or mental health problems, and if these
problems prevented them from performing usual activities. Finally, respondents are asked to
report their education level, race, and age.

CAHPS Questions

To make responses comparable to civilian surveys, the questions are similar in content and format to
guestions used in the Consumer Assessment of Health Plans Survey (CAHPS). CAHPS is a survey
program sponsored by the Agency for Health Care Research and Quality, U.S. Department of Health
and Human Service, and the Picker Institute, which is designed to monitor beneficiaries’ satisfaction
with their civilian health care plan and access to health care services. In 2004, CAHPS version 2.0
guestions were replaced with questions from version 3.0. As a result there are many changes in
guestion wording.

Quarter lll Supplements

= Referrals To Specialists. Questions in this supplemental concern the experiences of getting
referrals to specialists through TRICARE Prime. Respondents are asked to describe their
experience obtaining appointments with specialists and assess the travel distance to the specialist.

= TRICARE Civilian Network. These supplemental questions provide information about
respondents’ experiences with the TRICARE civilian network. Questions concern the amount of
care received, problems getting wanted care, convenience of care, and physician retention within
the TRICARE civilian network.

Sample Design Overview

The sample of beneficiaries for the HCSDB was drawn from an extract file of the DEERS database of
military health system (MHS) beneficiaries with a specific reference date. The DEERS extract file
includes all eligible MHS beneficiaries as follows:

= Everyone in the Uniformed Services and on active duty (Army, Air Force, Navy, Marine Corps,
Coast Guard, the Commissioned Corps of the Public Health Service, National Oceanic and
Atmospheric Administration, Guard/Reserve personnel who are activated for a period in excess of
30 days, and other special categories of people who qualify for benefits)

=  Those who retired from military careers
» Immediate family members of people in the previous two categories
= Surviving family members.

A stratified sample design was used to select DoD health care beneficiaries for the Quarter 11l 2004
Adult HCSDB. Strata were defined by a combination of enrollment status groups, and beneficiary
groups, and geographic areas. Specific information on the sample design appears in “Health Care
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Survey of DoD Beneficiaries: 2004 Adult Sampling Report”, Mathematica Policy Research,
Washington, D.C.

From a sample of 50,000 beneficiaries, 13,818 adult MHS beneficiaries completed and returned a
2004 Adult HCSDB questionnaire for the second quarter during the period, yielding a response rate of
29 percent. Information on developing response rates can be found in the "2004 Health Care Survey
of DoD Beneficiaries: Adult Technical Manual."

Other Documents on the 2004 HCSDB

This document is intended for programmers and analysts using the 2004 Adult HCSDB data. The
following is a list of other documents that may be requested from the TRICARE Management Activity
Office:

= Health Care Survey of DoD Beneficiaries: 2004 Adult Sampling Report

= The 2004 Health Care Survey of DoD Beneficiaries: Adult Technical Manual (available
February 2005)

= The 2004 Health Care Survey of DoD Beneficiaries: TRICARE Annual Report (available February
2005)
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Description of the Adult HCSDB Database

This chapter presents the procedures for developing the database, and presents the database file
layout.

Variable Naming Conventions

The conventions used to name variables on the 2004 Adult HCSDB data file are listed below and
summarized in Table 2.1. The naming conventions will remain constant across the four quarters
of the 2004 HCSDB.

Survey Variables. Core survey variable names consist of up to eight alphanumeric characters
that start with an alpha character ("H" for Adult survey variables), followed by a year designation
(“04") and ending with three numbers and, if necessary, one alpha character to identify the relevant
survey question. Recoded variables have the same names as on the survey. The original
variables are suffixed with “_QO"; these will not be on the public release file.

Supplemental Question Variables. Each quarter, the questionnaire includes a battery of
guestions on specific health care topics concerning services offered to MHS beneficiaries. The
supplements in the second quarter contained questions relating to beneficiaries’ chronic
conditions, and TRICARE's civilian network. Like the core questions, supplemental questions also
include eight alphanumeric characters; each variable begins with an “S” to distinguish it as a
supplemental question, followed by the year designation (“04"). The variable ends with an alpha
character and the question number in the supplemental series.

Self-Reported Data. Defense Manpower Data Center (DMDC) standard demographic self-
reporting variables on the adult survey are prefixed with “SR.” Survey variables with this naming
convention include SRRACEA-SRRACEE (race/ethnicity) and SREDA (education).

Coding Scheme Flags and Counts. Coding Scheme flags, variables N1-N23, reference the
notes in the Coding Scheme for Adult Survey. See Appendix C for the Coding Scheme for
Quarter Ill for more information. Coding Scheme counts are sums of missing value responses for
each questionnaire; each of these variable names begins with the 4 characters “MISS”".

Constructed Independent Variables. Independent variables are prefixed with an "X." These
include original survey variables modified as a result of data cleaning or recoding and newly
constructed variables that did not previously exist on the survey file. For example, since the
variable SRSEX was modified as a result of data cleaning and recoding, it was renamed XSEXA.

Constructed Dependent Variables. Dependent variables are given different prefixes depending
on function. Healthy People 2010 variables, for example, are prefixed with an "HP” and all other
newly constructed dependent variables are prefixed with a "K."

Weighting Variables. Quarterly weighting variables are prefixed with a "W."
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TABLE 2.1

NAMING CONVENTIONS FOR 2004 HCSDB VARIABLES — QUARTER IlI

1% Character: 2M_ 3" 4" _ 6™ Characters: Additional Characters:
Survey Type Character Question # Additional Information
s:
Survey
Year
H= Health 04 001 to 085 Ato O are used to
Beneficiaries (18 and label responses
older, Adult associated with a
Questionnaire) multiple response
guestion

_Odenotes an
original version of a
recoded variable

S = Supplemental Quarter Il
Question R0O1-R15 — Supplemental questions about
referrals to specialists.

V01-V02, V04-VO7 — Supplemental
questions about TRICARE’s civilian network.

1% Characters: Additional Characters:

Variable Group Additional Information

SR=Self-reported demographic data Descriptive text, e.g., SREDA

N=Coding scheme notes Number referring to Note, e.g., N2

X=Constructed independent variable Descriptive text, e.g., XREGION

HP=Constructed Healthy People Descriptive text, e.g., HP_BP (had blood pressure

2010 variable screening in past two years and know the results)

K=Constructed dependent variables Descriptive text, e.g., KMILOPQY (total number of
outpatient visits to military facility)

Cleaning and Editing Conventions

Data quality procedures are found in the Coding Scheme tables. The complete Coding Scheme
appears in Appendix C. It contains detailed instructions for all editing procedures used to correct data
inconsistencies and errors. Editing procedures check for appropriate response values and consistent
responses throughout the questionnaire. The steps to insure data quality include the following:
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= Initial Cleaning. Missing value flags were encoded when NRC created the SAS dataset:

- Skipped items were encoded with SAS missing value code of *.".

- Multiple responses, where there should be a single response, were encoded
with SAS missing value “A’.

= Data Cleaning and Recoding of Variables — Implementation of the Coding Scheme. Skip
patterns were checked for consistency, and questions that were skipped legitimately were recoded
with the SAS missing value of “.N”; questions that were answered, but should have been skipped,
were recoded with a SAS missing value of “.C”. When possible, variables were backward coded or
forward coded to make all responses consistent within a sequence. Numeric values were
checked, and values that were out of range were flagged with the SAS missing value of “.0".

* Frequency Checks. Formatted and unformatted frequency tables for all variables in the 2004
Adult HCSDB Quatrter Ill data file appear in Chapter 4 of this document. These frequency tables
and other relevant cross tabulations were used to examine the range of values recorded for each
data item to determine the type and magnitude of missing values. All value labels have been
checked for accuracy.

Record Selection Criteria

Blank returns, nonrespondents, and any respondents found to be ineligible for MHS benefits were
removed from the database. In addition, among eligible respondents with a non-blank questionnaire, a
guestionnaire must be “complete” to be included in the database.

To determine if a questionnaire is “complete”, 26 key questions were chosen. These key questions
were adapted from the complete questionnaire rule developed by AHRQ for CAHPS surveys. At least
50 percent of these key items (thirteen or more) must be answered for a questionnaire to be accepted
as a complete questionnaire. The key survey variables are: H04006, H04008, HO4009, H04010,
H04011, H04012, H04014, H04015, H04017, HO4018, H04019, H04020, H04022, H04025, H04026,
H04028, H04031, H04038, H04039, H04044, H04046, HO4052, H04054, HO4075, SREDA, HO4085.

Weighting Procedures

The analysis of survey data from complex sample designs, such as the 2004 Adult HCSDB, requires
weights to do the following:

= Compensate for variable probabilities of selection
= Adjust for differential response rates

= Improve the precision of the survey-based estimates through post-stratification [for details, see
Brick and Kalton (1996) and references cited therein)].

Sampling weights are equivalent to the reciprocal of the probability of each respondent’s selection into
the sample. Sampling weights are further adjusted for nonresponse within classes defined by sampling
strata: a cross-classification of enrollment status, geographic area, and beneficiary group. Chapter 4
contains the weighted and unweighted frequencies for each variable in the second quarter of 2004.
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Chapter

Programming Guide

This chapter is designed to help users create tables and variance estimates. Procedures for using
SAS, SPSS, SUDAAN, and WesVarPC to create estimates are explained. Examples provided in the
text are based on the second quarter of data from the 2004 HCSDB.

How To Make a Table Using SAS

The 2004 Adult HCSDB dataset is provided in a Statistical Analysis System (SAS) 6.0 format. SASis a
computer software system used for data management, summarization, and analysis. Later versions of
SAS can also read version 6 datasets. A format library for the adult database is included along with the
dataset. SAS can be run interactively or non-interactively (in batch mode), and the sample programs
presented here can be run using either method. Special instructions are given later in the chapter for
working interactively with the SAS Display Manager System in a Windows environment. All SAS
programs generate a LOG and a LST file. The LOG file shows how SAS interprets your program and
flags SAS syntax errors. The LST file shows the requested output.

File References, Libraries, and Options

SAS recognizes two types of datasets -- permanent and temporary. Permanent datasets, such as the
HCSDB, are located through a LIBNAME that references the directory where the data is stored. For
example, if the adult dataset for Quarter Il is located on a CD-ROM in the subdirectory
HCSDBO4\FORMA\Q3, your LIBNAME statement must look like this:

LIBNAME INFORMA 'F:\HCSDBO0O4\FORMA\Q3’;

The adult dataset can then be referred to as INFORMA.HCSDBO04, where INFORMA is the location of
the file HCSDBO04.

Aformat library requires a LIBNAME LIBRARY statement that shows the location of the format library.
For example, if the adult format library is stored on your hard drive in a FMTLIB subdirectory, the
LIBNAME statement should look like this:

LIBNAME LIBRARY 'C:\HCSDBO4\FORMA\Q3\FMTLIB';

The OPTIONS statement controls page format and line length. A table with a “portrait” orientation might
have this statement:

OPTIONS PS=79 LS=132;
A table with a “landscape” orientation that is left justified would have this OPTIONS statement:

OPTIONS PS=50 LS=175 NOCENTER,;

11/19/04
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DATA Step

The DATA step is used to create permanent or temporary datasets. It is also used to create new
variables, modify existing variables, and limit the number of variables or observations. In a DATA step,
you can do any or all of the following activities:

= Construct new variables. For example, to construct a variable of active duty by sex:

/* Active duty males */

IF XSEXA =1 AND XBNFGRP =1 THEN XSEX_AD =1,

* Active duty females;

ELSE IF XSEXA =2 and XBNFGRP =1 THEN XSEX_AD = 2;
ELSE XSEX_AD =.; /* missing value */

[Note: the two methods to insert comments: enclosed within /* */ or beginning with * and ending
with a semicolon]

» Modify existing variables. For example, if the respondent is in region 7, the respondent will be
placed in the combined region 7/8:

IF XREGION =7 THEN XREGION =8

= Limit the number of variables. Use a KEEP statement:
KEEP XREGION CACSMPL H04057 H04014;

=  Limit the number of observations. Use a subsetting IF:

I* Keep only region 3 observations */
IF XREGION = 3;

= Create a new temporary dataset. For example, CAC_1 is atemporary file of observations for only
those respondents in catchment area 1.

LIBNAME INFORMA 'F:\HCSDBO0O4\FORMA';
DATA CAC 1;

/* Input file is HCSDB04 */

SET INFORMA.HCSDBO04;

IF CACSMPL =1,

RUN;

= Create a new permanent dataset. For example, OUT.CAC_9901 is a permanent dataset only of
Region 1 out-of-catchment respondents:

LIBNAME INFORMA 'F:\HCSDBO4\FORMA';
LIBNAME OUT 'C:\HCSDBO4\FORMA’;
DATA OUT.CAC_9901;

SET INFORMA.HCSDBO04;

IF CACSMPL = 9901;

RUN;
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PROC TABULATE

PROC TABULATE produces summary statistics in a table layout. The table can have up to three
dimensions: page, row, and column. Within any dimension, multiple variables can be reported one
after another or hierarchically. Useful statistics that are available in PROC TABULATE include:

= N number of observations with nonmissing values

=  NMISS number of observations with missing values

= MEAN the arithmetic mean

= SUM the sum

= PCTN percent that one frequency represents of another frequency
= PCTSUM percent that one sum represents of another sum

The essential elements to execute PROC TABULATE are outlined below (items within < > are not
required):

PROC TABULATE DATA=your dataset <option list>;

CLASS class variables;

VAR analysis variables;

TABLE << page expression, >row expression, > column expression </ table options >;
WEIGHT WRWT;

RUN;

If the input file is to be limited to a specific population, a separate DATA step can precede the
TABULATE, or a WHERE statement can be used within the TABULATE procedure. For example, to
create a table from only respondents in catchment area 1, you would use the following statement after
the PROC TABULATE statement:

WHERE CACSMPL =1;

CLASS variables are any variables that are used for grouping; variables such as XREGION, XSEXA,
and CACSMPL are good examples of class variables. Class variables can be either character or
numeric and typically have a discrete number of values. Unless MISSING is specified in the options list
in the PROC TABULATE state, any observations with a missing CLASS variable will be dropped from
the table.

The VAR statement identifies all analysis variables for a table. Analysis variables must be numeric and
can be either discrete or continuous. SAS excludes missing values when computing statistics such as
means and percentages.

The WEIGHT statement identifies the numeric variable whose value is used for weighting each
analysis variable. In the HCSDB for 2004, the weight variable is WRWT.

The TABLE statement defines the table features. Every variable listed in this statement must be
classified as either a class variable or an analysis variable in the CLASS or VAR statements. A
comma separates each table dimension (page, row, and column). If there are three dimensions,
the first is the page, the second is the row, and the last is the column. If there are only two
dimensions, the first is the row and the second is the column. Tables with only one dimension
are in column form. Each dimension expression is composed of the same following elements:

= Analysis variables

11/19/04 11
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Class variables

The universal class variable ALL, which summarizes the class variables in the same group or
dimension

Keyword for the statistic to be performed, such as MEAN, SUM, or PCTSUM

A format modifier, which defines how to format values in cells. For example, F=8.2 will present
values with a maximum of 8 positions and 2 digits to the right of the decimal.

Labels, which temporarily replace variable names and statistic keywords. These labels have the
form ='label’; for example, XREGION="Region’ or MEAN="" (to eliminate the word MEAN from the
headings).

Crossing operator * (asterisk). The asterisk is used to cross elements within the same dimension.
For example, you would use XENRLLMT*XSEXA to cross enrollment status by sex. The asterisk
is also used to connect the statistic (e.g., MEAN, SUM) to the appropriate dimension; for example,
to calculate the mean of respondents’ satisfaction with all health care in the last 12 months, you
would use H04038 *MEAN.

Denominator definitions are enclosed by < > (brackets).
Concatenation operator is a single space between elements in a dimension. For example, to
concatenate satisfaction with all health care in the last 12 months with satisfaction with health plan,

you would use H04038 H04054.

Grouping is accomplished with parentheses. Below is an example of grouping, concatenation, and
crossing within a single dimension;

(XBNFGRP ALL)*XSEXA

The SAS Display Manager System

The SAS Display Manager system provides an interactive tool for running SAS commands, like those
given above, in the Windows environment. Double clicking the SAS icon on the desktop begins the
SAS session. When you first enter SAS version 8, the following screen opens.
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The screen is divided into two windows, a Log window above and an Editor window below.

The Window Bar at the bottom of the screen includes tabs for the Log and Editor windows with an
additional tab for the Output Window. Clicking on the Output tab will open the Output window. The
instructions in this document will outline options for setting up the Editor and for displaying the windows
themselves.

The default editor for version 8 is the SAS Enhanced Editor which is color coded to check SAS syntax.
Another editing option is to use the Program Editor which includes line editing options. We will describe
procedures for setting up the Program Editor.

Click on View and select Program Editor as in the following:
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The lower Editor Window has now changed to Program Editor as in the following screen:
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Open the Tools menu and choose Options and preferences.
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Many of these settings are system default options. To add a command line to the three windows, do
the following. Click on the View tab and click in the box opposite Command Line as follows:
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Click on OK and a command line will be added as in the screen below.
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Each window shows the word Command followed by an arrow. Commands may be typed at this
location. To arrive at the command line, depress the Home button on your keyboard. The cursor will
appear opposite the arrow.

Toggling among the windows may be accomplished by typing the desired window name at the
command line and pressing Enter. SAS recognizes Pgm as the abbreviated reference to the Program
Editor and Out as a shortened name for the Output window. A few keystrokes allows you to navigate
among the windows. For example, the command line lets you continue to customize our SAS session
as follows.

In order to more easily distinguish between the SAS windows, it may be preferable to change the
background color of selected windows. As an example, set the background color of the Log window to
yellow and the Output window to gray. Press the Home key to arrive at the command line. Type Log
opposite the arrow to toggle to the Log window. Type the command, color back yellow (or some other
color) on the command line. Your screen will resemble the following.
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Press Enter to process the commands and the window will shade to yellow. Toggle to the Output
window by typing Out and keying Enter. Type color back gray and key Enter. Return to the Program
Editor and the screen will look like the following.
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All SAS statements for building and processing SAS datasets are typed into the Program editor. A SAS
session may involve typing statements like the ones above for library reference, computing new
variables, data steps, etc. Entering a long series of statements in such a small space may be awkward,
so another arrangement for the windows may be preferable.

Cascading the windows is one option. To cascade the windows, open the Window menu, and choose
Cascade as indicated in the following.
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Clicking the option Cascade produces the following result.
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Each window is partly superimposed on the other. The colors distinguish between windows at a glance.
With the Program Editor in front, SAS statements may be typed there with relative ease. As a final
option, you can enlarge the Program Editor to fill the entire screen. Atthe command line, type zoom as
in the following:
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The window changes to fill the screen.

One more option for customizing screens is explained below. This involves adding line numbers to the
editing environment in the Program Window. After adding the line numbers, many useful line-editing
commands become available (see the SAS Manual). At the Command line type “numbers on” as in
the following screen.
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The line numbers appear at the left of the full screen Program Editor as in the screen below, and the
SAS statements can be typed into the screen and edited.
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Below is an example of a PROC TABULATE to construct a table of health care variables by beneficiary
group by gender for respondents in region 3. Beneficiary group (XBNFGRP) and sex (XSEXA) are both
class variables with a discrete number of values. The columns of the table are beneficiary group
broken out by sex, a total for each beneficiary group, and a region total. The health care variables
(HO4054 and H04075) are the analysis variables appearing as the rows of the table. The statistic that
we want to see is the weighted mean of these variables for each group in the table and for the entire
region as a whole.

Enter the following SAS statements into the Program Editor.

OPTIONS PS=79 LS=95;

LIBNAME IN 'C:\FILES\DoD\ADULT 2004,

LIBNAME LIBRARY ‘C:\FILES\DoD\ADULT 2004\FMTLIB’;

PROC TABULATE DATA=IN.HCS043_1;

WHERE XREGION = 3; /*limit to Region 3 */

CLASS XBNFGRP XSEXA,;

VAR H04054 H04075;

WEIGHT WRWT;

TABLE (H04054 HO4075)*MEAN, /* Row Dimension */
XBNFGRP*(XSEXA ALL) ALL; /*Column Dimension */

TITLE “Table 3.1";

TITLE2' Constructed Beneficiary Group by Gender for Region 3';

RUN;

Key Home and type the command SUBMIT on the Command Line. Submit instructs the SAS system
to process the commands written in the Program Editor. Your screen should resemble the following.
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Enter the Submit command, and the SAS statements disappear from the Program Editor.
If a table is successfully produced, the Output window will open and the table will be displayed. If no
output is produced, then SAS has encountered an error. SAS statements about the error can be seen
and evaluated in the Log window. In all cases, the Log window should be carefully examined after SAS
statements are processed. SAS may produce a table even if there are errors in the program, so the
table may not be correct.

No table was produced for this run. The error is indicated in the Log Window as shown below.
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The variable CRWT was not found in the dataset. Type Pgm on the Command line to return to the
Program Editor. Type Recall on the Command line and the program statements will reappear in the
window.
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You can correct the error by entering WRWT, the correct variable name, in the weight statement.
Then, rerunning the procedure.

The corrected program produces the following output.
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The result of this process is Table 3.1.

Note that the TITLE statement defines the heading for each page. Titles of more than one line are
entered as TITLE, TITLE2, etc.

Table 3.1
Constructed Beneficiary Group by Gender for Region 3

I I I I I
+ + + + +
|Rating of |[Mean | | | | |
|a11 | | | | | |
|lexperien- | | | | | |
e with | | | | | |
[hlth plan| | 7.22| 6.59| 7.10| 7.61| 7.22
R L + + +
I I I I I
I I I I I
I I I I I
I I I I I
I I I I I

EEEREEERE LARSREERREE
|In gnrl, |Mean

|how would|

|you rate |

|ovrall |

|h1lth |

(Continued)
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Table 3.1
Constructed Beneficiary Group by Gender for Region 3

I I
I I
| | | |Ret/Surv/Fam|
I I I | 65+ I
| | | Ret/Surv/Fam <65 [-------e----
| | Family of |----rommmmm i | Male or |
| | Active <65 | Male or Female - R | |Female - R |
| EEERIERTOPE LCREEITTEPILRLRPERIITPE | EEEERCRIEORE |
| | All | Male | Female | All | Male
| -------------------- S, Fom e S, S, S,
|Rating of |[Mean | | | | | |
a1l | | | | | | |
lexperien- | | | | | | |
lce with | | | | | | |
[hlth plan| | 7.23| 7.40| 7.61| 7.51| 8.66|
| --------- [ S S, S, S, Fomm e S,
|In gnrl, |Mean | | | | | |
|how would| | | | | | |
lyou rate | | | | | | |
lovrall | | | | | | |
[h1lth | | 3.62| 3.34| 3.44| 3.39| 3.29|
(Continued)
Table 3.1
Constructed Beneficiary Group by Gender for Region 3

| | Constructed Beneficiary |

| | Group | |

| [ | |

| | Ret/Surv/Fam 65+ | |

| [ | |

| | Male or | | |

| |Female - R | | |

| EEEREERIEORE | | |

| | Female | All | All

| -------------------- S, S, S, |

|Rating of [Mean | | | |

a1l | | | | |

lexperien- | | | | |

lce with | | | | |

[hlth plan| | 9.03| 8.83| 7.82|

| --------- [ S S, S, S,

|In gnrl, |Mean | | | |

|how would| | | | |

lyou rate | | | | |

lovrall | | | | |

[h1lth | | 3.02| 3.15| 3.40|
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Using Formats

The format library is the key to interpreting values of discrete variables. For example, in the program
above, the format library found at C:\FILES\DoD\ADULT 2004\FMTLIB indicates that a VValue of 1 for
XSEXA means male, and a value of 2 for XSEXA means female. Similarly, if XBNFGRP equals 1, the
respondent is active duty; if XBNFGRP equals 2, the respondent is a family member of active duty
personnel; if XBNFGRP equals 3, the respondent is an under-65 retiree or a survivor or one of their
family members; if XBNFGRP equals 4, the respondent is a 65-or-over retiree, survivor, or one of their
family members.

Since formats are associated with the variables in the HCSDB, formatting is automatic as long as SAS
can locate the format library. Error messages will result if the LIBNAME LIBRARY statement is not
present. If the format library is not available for some reason, use the statement

FORMAT ALL_;

within the PROC TABULATE to prevent SAS from searching for the missing format library. The default
formats in the format library were used to produce the table described in the previous section.

Table Appearance

Format modifiers and temporary labels improve the appearance of a table. In Table 3.1, the values of
the statistics are of the form x.xx. If each cell is defined to be six positions wide with two positions to the
right of the decimal, there is adequate space plus some extra room to keep the table from looking
crowded. This is done by crossing the statistic with the format modifier:

MEAN*F=6.2

Labels are attached to all variables in the HCSDB. You can use temporary labels to override the label
within the SAS dataset. It is not always necessary to use both the variable label and the formatted
values for each value of a class variable. In the previous example, the formatted values of XBNFGRP
are active duty, family members of active duty, etc. which we know to be beneficiary groups; the title
also tells you that these are beneficiary groups. The table can be made attractive by deleting the
heading for XBNFGRP by including a blank for the temporary label:

XBNFGRP="*

Similarly, because the statistic being reported here is a mean, you do not need MEAN on each row.
You can add or eliminate a label and include a format modifier to the same variable:

MEAN=" "*F=6.2
The headings for XSEXA and ALL can be improved:

XSEXA='Gender’
ALL="Group Total’ for the ALL that is crossed with XBNFGRP
ALL="Total’ for the Region 3 total

The new program looks like this:

OPTIONS PS=79 LS=95;

LIBNAME IN 'C:\FILES\DoD\ADULT 2004';

LIBNAME LIBRARY ‘C:\FILES\DoD\ADULT 2004\FMTLIB’;
PROC TABULATE DATA=IN.HCS043_1,

WHERE XREGION = 3; /*limit to Region 3 */

CLASS XBNFGRP XSEXA;

VAR H04054 H04075;
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WEIGHT WRWT,;

TABLE (H04054 HO4075)*MEAN="‘*F=6.2, /* Row Dimension */
/* Column Dimension */
XBNFGRP=" “*(XSEXA="Gender’ ALL="Group Total’)
ALL="Total’;

TITLE “Table 3.27;
TITLE2 ‘Constructed Beneficiary Group by Gender for Region 3';
RUN;

Typing these statements into the Program Window produces the following screen.
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After the Submit command is entered, the following table is displayed in the Output window.
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The resulting output is in Table 3.2.

Table 3.2
Constructed Beneficiary Group by Gender for Region 3

| | Active Duty <65 |Family of Active <65| Ret/Surv/Fam <65 |
| EERREEEEEEEEREEEREE booon booon |
| |  Gender | |  Gender | |  Gender | |
| [------eme- - |Group |------------- |Group |------------- |Group |
| Male |Female|Total | Male |Female|Total | Male |Female|Total |

I

+

|Rating of| |

a1l | |

|experien- | |

|ce with | |
|h1th plan]| | 7.22

+

I

I

I

I

I

|how would|
|you rate |
|ovrall |
[h1lth |

(Continued)

11/19/04 25



2004 HEALTH CARE SURVEY OF DOD BENEFICIARIES — QUARTER Il

Table 3.2
Constructed Beneficiary Group by Gender for Region 3

[<=mmemaia e |Group |

I
+
|Rating of| |
a1l | |
|experien- | |
|ce with | |
|hlth plan| | 8.66
| --------- [ S +
|In gnrl, | |
|how would| |
|you rate | |
|ovrall | |
|hlth | |
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Although the label for MEAN is deleted, there is still a space in the table for this label. You can eliminate
this blank space by using the TABLE option of ROW=FLOAT. SAS row headings are automatically
allocated; you can override this by using the TABLE option of RTS=n where n is an integer value
specifying the number of print positions to be used for row headings. If you decide that we don’t need
the label ‘Gender’ for XSEXA because ‘male’ and ‘female’ are self-explanatory, the revised program is

as follows:

OPTIONS PS=79 LS=95;

LIBNAME IN ‘C:\FILES\DoD\ADULT 2004';

LIBNAME LIBRARY ‘C:\FILES\DoD\ADULT 2004\FMTLIB’;
PROC TABULATE DATA=IN.HCS043_1,

WHERE XREGION = 3; /*limit to Region 3 */

CLASS XBNFGRP XSEXA;

VAR H04054 H04075;

WEIGHT WRWT;

TABLE (HO4054 HO4075)*MEAN=" *F=6.2, /* Row Dimension */

[* Column Dimension */

XBNFGRP=" “*(XSEXA="" ALL="Group Total’)
ALL="Total’ / ROW=FLOAT RTS=32;

TITLE “Table 3.3";

TITLE2' Constructed Beneficiary Group by Gender for Region 3';

RUN;

Typed into the Program Window, the revised program appears as follows.
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The output table is displayed in the Output Window as follows.

L
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The result is Table 3.3.

Table 3.3
Constructed Beneficiary Group by Gender for Region 3

|In gnrl, how would you rate
|ovrall hlth

I
| - - oo | <65 |
| | | |Group | | |Group | --------nnn-- |
| | Male |Female|Total | Male |Female|Total | Male |Female|
| ------------------------------ [ [ R [ [ R [ R Foemmmn [ R [ R
|Rating of all experience with | | | | | | | |
[hlth plan | 7.22| 6.59| 7.10| 7.61| 7.22| 7.23| 7.40| 7.61|
[ [ [ [ [ R [ [ [ |
I
I

(Continued)

Table 3.3
Constructed Beneficiary Group by Gender for Region 3

| |Ret/S- | |
| |urv/F-| |
| |am <65| Ret/Surv/Fam 65+ |
I
I
I

|Rating of all experience with |
[hlth plan | 7.51| 8.66] 9.03| 8.83] 7.82|
| ------------------------------ [ [ [ [ [ R |
|In gnrl, how would you rate | | | | |

|ovrall hlth | 3.39] 3.29] 3.02| 3.15| 3.40|

Calculating Percents
When calculating percentages, it is necessary to appropriately define the denominator. To calculate a
column percentage, the denominator definition must include all class variables that define the row. For
example, if you want to look at the percentage of people in your region and each of the catchment
areas who answered yes (or no) to question 14, ‘In the last 12 months, did you see a specialist?', your
TABLE statement in the TABULATE procedure would look like this:

WHERE XREGION = 6;

TABLE H04014 ALL="Total’,
(All="Region Total’ CACSMPL)*PCTN<H04014 ALL>='Percent’;

Table 3.4 includes a program and its output for calculating column percentages.
The program statements in the Program Editor appear as follows.
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Table 3.4
People Who Saw a Specialist in the Last 12 Months
for Region 6 Catchment Areas

| |Little Rock | Barksdale

I I I

| |Region Total]| AFB | AFB | Ft. Polk | Tinker AFB |
| | ------------ Fomm e s S, Fomm e Fomm e
I | # | % | # | % | # | % | # | % | # | %

| ----------------------- F [ F [ R F Foemmmn F S, Foemmmn F S, [ R
|In 1st yr:did you see a| | | | | | | | | |

| specialist I I I I I I I I I I

| oo | I I I | |
|Yes | 822] 53.27| 42| 46.67| 48| 48.00]| 49| 51.58| 59| 49.58|
| ----------------------- oo [ [ oo oo [ [ +o---- [ [ [ |
|No | 721| 46.73| 48| 53.33| 52| 52.00]| 46| 48.42| 60| 50.42|
| ----------------------- [ [ [ [ +o---- [ +o---- oo oo - oo [ |
| Total | 1543]|100.00]| 90]100.00| 100]|100.00]| 95]|100.00| 119]100.00]|

(Continued)
Table 3.4
People Who Saw a Specialist in the Last 12 Months
for Region 6 Catchment Areas
| | | Brooke AMC- | | | Laughlin |
| | | Ft. Sam | | | AFB/Sheppard |
| | Ft. 8ill | Houston | Ft. Hood | Dyess AFB | AFB
| | ------------ S, S, S, S,
I L # 1 % | # | % | # | % | # | % | # | %
| ----------------------- toeo-- [ R F [ F S, [ R E Foemmmn toeo-- [
|In 1st yr:did you see a| | | | | | | | | |
|specialist I I I I I I I I I I
| | | | | | |
|Yes | 50| 54.95] 88| 59.086| 69| 48.25] 49| 44.55| 54| 56.25|
| ----------------------- +o--- - [ +o---- [ +o---- [ R, +o---- [ +o---- [ R, |
[No | 41| 45.05] 61| 40.94| 74| 51.75| 61| 55.45| 42| 43.75]|
| ----------------------- +o---- [ +o---- [ +o---- [ +o---- [ +o---- [ |
| Total | 91[100.00| 149|100.00| 143|100.00| 110]|100.00]| 96(100.00|
(Continued)
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Table 3.4
People Who Saw a Specialist in the Last 12 Months
for Region 6 Catchment Areas

| | | NH Corpus | |Out/Area-Reg|
| |Lackland AFB| Christi |Randolph AFB| 2

| | ------------ Fomm e S, S, |
| | # | % # | % | # | % # | %

| ----------------------- F [ R F S, Foeommn F Foemmmn F [ R
|In 1st yr:did you see a| | | | | | | |
|specialist I I I I I I I I
| | | | | |
|Yes | 64| 50.00] 44| 45.36| 65| 59.63| 141| 65.28|
| ----------------------- [ [ [ oo oo - [ [ [ [ |
[No | 64| 50.00] 53| 54.64| 44| 40.37| 75| 34.72|
| ----------------------- [ oo oo - oo [ [ [ [ oo oo - |
| Total | 128|100.00| 97|100.00| 109|100.00| 216]100.00]|

The statistic N is included with PCTN to make it easier to verify that the denominator definitions have
been set up properly. After you check to see that the percentages are accurate, the N statistic can be
removed. Note that the output for Table 3.4 is unweighted. The N statistic (and PCTN statistic) is
always unweighted even if a WEIGHT statement is included.

Similarly, if you want to look at the percentage of TRICARE enrollees (and non-enrollees) by gender
who report seeing a specialist in the past 12 months, this would be a row percentage. To calculate a
row percentage, the denominator definition mustinclude all class variables that define the column. Your
TABLE statement would look like this:

TABLE H04014 ALL="Total’,
XENRLLMT *(XSEXA="" All="Group Total")*
PCTN<XENRLLMT*XSEXA XENRLLMT*ALL>="Percent’;

Notice that there are no parentheses used in the denominator definition. Because parenthetical
groupings are not allowed in the denominator definition, all crossings and concatenations must be
included. As noted above, the N and PCTN statistic are unweighted counts of CLASS variables. If you
want to produce a weighted count and percentage for this table, you would include WRWT (the 2004
weight variable) as an analysis variable in the VAR statement and in the column crossing of the TABLE
statement; the statistics to be generated should be specified as SUM and PCTSUM. A program and
output to demonstrate weighted row percentages appears in Table 3.5.

The following screen shows the new program typed into the Program Editor.

11/19/04

32



2004 HEALTH CARE SURVEY OF DOD BENEFICIARIES — QUARTER I

B
EPERL AT = TR R )

"ll:llluiI.I"'.
PO O HEER T
s 3

[

Here, as above, the SUM statistic is included to help determine the accuracy of the denominator
definition.

Additional information about running SAS is available from the SAS Institute. Please consult the
appropriate manuals for more detailed information.

See Table 3.5 to view the entire table.
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Table 3.5
People Who Saw a Specialist in the Last 12 Months
by TRICARE Prime Enrollment and Gender
Region 6 Only

I

| | Active Duty - under 65 R LR T
| | | | |Group |
| | Male | Female |Group Total | Male | Female | Total |
| | ------------ o o o o Fo-ooo -
I L # | % | # | % | # | % | # | % | # | % | # |
| -------------- Fo-oo- - +----- +o-oo-- +----- Fo-oo-- +----- Fo-ooo - +----- Fo-oo-- +----- Fo-ooo -
[In 1lst yr:did | I I I I I I I I I I I
|you see a I I I I I I I I I I I I
|specialist I I I I I I I I I I I I
EERRREEEEEEEE | | | | | | |
|Yes | 33818| 8.20| 14731| 3.57| 48549|11.77| 38644| 9.37| 75256|18.25|113900|
| -------------- Fo-oo-- +o---- Fo-ooo- +----- Fo-oo-- +----- Fo-ooo - +----- Fo-oo-- +----- Fo-oo--
| No | 65957|22.94| 20776| 7.23| 86734|30.16| 30655|10.66| 61649|21.44| 92304
| -------------- Fo-oo-- +o---- Fo-ooo- +----- Fo-oo-- +----- Fo-ooo - +----- Fo-oo-- +----- Fo-oo--
| Total | 99776|14.26| 35507 | 5.07|135283|19.33| 69299| 9.90|136905|19.56|206204 |
(Continued)
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Table 3.5
People Who Saw a Specialist in the Last 12 Months
by TRICARE Prime Enrollment and Gender
Region 6 Only

I |Enro- | I I
I [1lled | I I
| |under| |

I | 65 | I I
| |----- | Not enrolled - under 65 |Not enrolled - 65 or over|
| |Group | ----- - - P - - |
| | Total] Male | Female |Group Total | Male | Female |
| |----- oo oo oo oo oo
I % | # | % | # | % | # | % | # | % | # | % |
R T +o---- Fooo o +o---- oo +o---- oo +o---- +ooo - +o---- +ooo o +o----
[In 1st yr:did | I I I I I I I I I I I
[you see a I I I I I I I I I I I I
|specialist I I I I I I I I I I I I
|- I I I I I I I I I I I I
|Yes |27.62| 37833| 9.18| 60313|14.63| 98146|23.80| 87717|21.27| 64036|15.53|
R T +o---- [ +o---- oo +o---- oo +o---- L +o---- +ooo o +o----
| No |32.10| 28340| 9.86| 25232| 8.77| 53572|18.63| 19719| 6.86| 35226|12.25|
R T +o---- L +o-- - [ +o---- +ooo - +o---- [ +o---- L +o----
| Total |29.46| 66173| 9.45| 85545|12.22|151718|21.68|107436|15.35| 99262|14.18|
(Continued)
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Table 3.5
People Who Saw a Specialist in the Last 12 Months
by TRICARE Prime Enrollment and Gender
Region 6 Only

|Not enrolled|
| 65 or over |

| # | % |
| -------------- F S +o-- - |
|In 1st yr:did | | |
|you see a | | |
| specialist | | |
EREEREEEEEEEE | |
|Yes |151753|36.80|
| -------------- F S +o-- - |
[No | 54945(19.11]|
| -------------- F S [ S, |
| Total | 206698 |29.53|

How to Make a Table Using SPSS

The 2004 Adult HCSDB dataset is in an SPSS format. SPSS is a computer software system used for
data management, summarization, and analysis. SPSS can be run interactively, using menus, or in
batch mode, using syntax commands. This guide instructs users on how to use SPSS dialog boxes to:
= Construct new variables

= Recode existing variables

= Select cases for analysis

= Weight cases for analysis

=  Create customized tables

As you use the dialog boxes, you generate syntax automatically. This syntax may be pasted into a
syntax file for future use or for modification.

Locating and opening the datafile

To begin an SPSS session, double click on the SPSS icon on your desktop. The Data Editor window
will open and present a blank spreadsheet like the following screen:
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Click on File in the upper left corner to open the following menu:
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Select the Open option or choose a file from the list displayed. Open produces the following screen:
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If the file is not in this directory, navigate through your folders until you locate it. Mark the file and click
Open. You will be returned to the spreadsheet Data Editor with the file on view. The 2004 Adult HCSDB
dataset has been opened and is displayed below.
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Constructing new variables

Data can be evaluated from many different aspects. Itis sometimes useful to build new variables from
combinations of the existing ones and to examine their distributions.

For example, the variable in the file for beneficiary group at the time of sampling is called xbnfgrp, and
the variable for sex is xsexa. The value 1 for xbnfgrp indicates that the individual is on active duty. The
relationships for constructing a new variable of active duty by sex are:
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Active-duty-males: xsexa=1 and XBNFGRP=1
Active-duty-females: xsexa=2 and XBNFGRP=1

Open the Transform menu and select Compute as in the following:
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The following dlalog box will open:
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You can build the new variable in two steps to express the two conditions. The first task is to give the
new variable a name and its first value. Enter the Target Variable slot and name the new variable
sex_ad. Next, assign the value 1 to sex_ad by entering it into the slot for Numeric Expression. Your
screen should look like the following:
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Once you we have assigned the value 1 to sex_ad, you can build the condition that qualifies the
assignment. Click on If..and open the following dialog box:
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Click on the circle indicating Include if case satisfies condition, and the black dot will move to that circle.
The slot underneath will open, ready for your input. Build the “if” condition. Write it directly into the slot
or move the elements into the slot from the given options. Add the elements xsexa = 1 & xbnfgrp = 1.
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The screen should resemble the following:
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Click on Continue and return to the previous screen, which will now look like this:
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Your condition will be written next to the If button. Click on OK to exit the dialog box, and the variable
sex_ad will be created with its value set to 1.

The next step is to build the second condition for the new variable, which will set it to the value 2.
Reopen the Compute dialog box. The commands you just gave still appear in the dialog box. Simply
assign the value 2 to sex_ad, press If, and enter the new condition to identify active duty females.

Click Continue, and finish with OK. The condition, if xsexa = 2 and xbnfgrp = 1, will be added to the new
variable sex_ad.
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Once you have created a new variable, you may want to add it permanently to the dataset. The new
variable is computed for each case in the file and added to the view in the Data Window after the last
variable in the dataset. The variable name is the column heading.

Since the HCSDB data set carries Read-Only status to protect it from corruption, changes to it cannot
be saved. At the end of the day, when the work session ends and you exit SPSS, the file will revert to
its former status and the new variables will be lost. The solution is to save the dataset under a new
name when you exit. Choose the Save As option on the File menu, and you will be prompted to name
the file and to save it in a folder of your choosing. Give the file a new name and save it. Open the new
expanded file anytime for processing.

Suppose you do not want to use up your disk space for expanded copies of the dataset. Another option
is to save the syntax you have generated in a file that can be run as it is needed. Syntax is a written
instruction generated by the commands you give in a dialog box. These “sentences” can be savedina
file and executed when needed. This is the batch mode of processing syntax commands. Syntax files
take up very little space.

Experienced SPSS programmers, who have mastered SPSS syntax, often prefer to work only in batch
mode. This option is available to users who have not mastered the syntax language. You can paste the
commands, generated interactively in the dialog box, onto a syntax file.

Recall the compute example for the new variable sex_ad. The screen below is the result of assigning 1
to sex_ad according to an If condition. You clicked on OK to set the value. Returning to the screen and
clicking on Paste writes the command to a syntax file.
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Click on the Paste button, and the syntax window below will open with the syntax written in it.
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Now return to the compute dialog box.

B [F = s (e e e Sl b o)

(el ]l a1 s i

Gl i e

i A

m  mm T
_fﬁ!h'. . A i S s
[t | il R
i - T | H 0
"::‘" :]-_.| ilaf zim[nj reoem [2] o | | e
L [+ o 2 A e ol Zexil el
PR = =i~ Flm i g | m ammy usx s
o m 1) [1] =
- e - T e R
e Sl e S{INRESR, sl s
" T 0| DI (il T )
:":- J:"."l_l___!- __I m §im| (e T
b B e e m| am| |
e L) | e | | ks
L 1Rl s JLEE LR ]
Tl ESTH 7 S
wAT i TH| B [ g e
| | T | I (037
1m| I INDE | T ] 1m|  mm| |
TOEEOH | o ] | AN JUEF, CRIE
SErrEn AEEm 1 He & i (Es

TR T T I V| -l 1] ] i '.'.:'i-d._“

w

B P ) Sy e s o - I -

Assign the value 2 to sex_ad as in the diagram above. Select Paste, and these commands will be
appended to the syntax file.
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DAGEQY is a string variable. In order for it to be recoded using grouping criteria, it must be converted to a
numeric variable. In the data window go to the column for the variable DAGEQY and click in the gray area at the
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The results appear in the screen above. SPSS gives default names to syntax files, such as Syntax1,
Syntax2, etc., as they are created. It is a good idea to save the syntax, re-naming the file using the
Save As option on the File menu. Use a name that has some meaning to you, e.g., New_computes.

The file will automatically receive the suffix .sps.

Another option for adding new variables to the dataset is to Recode existing variables into new
variables. A common example involves grouping an age variable into age categories as shown below,
using the variable DAGEQY, which exists on our dataset. DAGEQY is coded in years from 18 to 96,

which can be grouped into four age categories:

18t0 34 =1 - label: “young adult”
351049 =2 - label: “mature adult”
50 to 65 = 3 — label: “middle-age”

66 to 96 = 4 — label: “senior citizen”

The new variable is called age_grp.

top of the column causing the variable to be selected as the following screen indicates.
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Click on the Variable View tab at the Lower Left of your screen and the screen will change to the following:
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In the Type column click on the gray square and the following Menu will open.
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Transfer the black dot from String to Numeric as follows:
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Click on OK to set the changes. Click on the Data View tab to return to the Data Editor window.

Now from the Transform menu, choose Recode and Into Different Variables as pictured below:
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The following dialog box will open:
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Move DAGEQY from the variable list on the left to the box labeled Input Variable -> Output Variable.
In the Name slot, enter the new variable name age_grp. Enter Age Categories, the variable label, in
the Label slot. Click on Change. The dialog box should look like the one below.
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Click on Old and New Values, and the following dialog box will open:
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The next step in grouping the age variable is to specify the existing values of Age to be recoded. To do
this, click on the Range circle under Old Value.
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Once the appropriate slots are open, you have four ranges to enter.

First, enter 18 through 34 in the slots provided under Range. Next, enter the value 1 in the Value slot
under New Value. Add is now illuminated.
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Clicking on Add produces the following result:
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The specified range appears in the box labeled Old -> New, and the Range and Value slots have
been cleared to permit additional entries.

The three remaining ranges are built in the same manner, adding each specification, until the dialog
box looks like the one below.
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Click on Continue and return to the previous screen.
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Click on OK to exit the screen. The new variable age_grp has been created. The Recode syntax can
be pasted to a syntax file.

The final task is to create the value labels for the new variable age_grp. Labeling variables makes
output from statistical reporting procedures much clearer and more elegant.

In the Data Window, go to the column for the new variable age_grp and double click in the gray area
containing the variable name. The screen will change to variable view:
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The variable age_grp is shown with its attributes.
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Click in the cell under Values and the following dialog box will open:
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You can then begin to label the values of age_grp. Enter 1 in the slot marked Value, and enter the
label Young Adult in the slot marked Value Label. The screen will look like the following:
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Add is now illuminated. Click on Add and the text of your command will appear in the central box,
clearing the slots for further entries, as in the next screen.
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Build the other three labels until the screen looks like the following:

Click on OK and the screen will appear as follows:
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Click on the Data View tab to return to the data screen.

Limiting the Number of Variables

The HCSDB dataset contains many variables. To speed up software performance time, it may be
desirable to limit the number of variables for analysis. There are ways to do this.

The first is to Save a subset of variables in a new file with a new name. This option is available only
through syntax. The Keep or Drop command lets you save a subset of variables. The choice of Keep
or Drop is dependent on which list is shorter to write.

For example, suppose you want to run some procedures to evaluate the rating of all experiences with
the health plan as it relates to the beneficiaries’ state of health. You are also interested in the
differences between military and civilian services, and in differences within these groupings by gender.
Moreover, you want to look at regional differences and differences among catchment areas. You can
do all the work on a subset of only nine variables, saving them in a separate file.

To write the syntax, open a syntax window. If you want to create a new syntax file, choose New,
Syntax on the File menu as in the following:
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A blank syntax window will open.
Write the following command, substituting the file name and directory specification:

SAVE OUTFILE="C:\MYFILES\HLTHCARE.SAV'/KEEP=XREGION XSEXA XENRLLMT
CACSMPL WRWT XBNFGRP H04014 H04054 H04075. as in the following:
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Upper case is optional. Be sure to enclose the entire file name in single quotes and to type a period at
the end of the command.

Run the command by choosing the Run menu and selecting All from the choices.
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Open the new file according to the specifications at the beginning of this chapter.

The second way to limit the number of variables for analysis is to define a subset of variables that will
appear in the dialog boxes for procedures. Using the Utility menu, define a subset of variables as in
the following:
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Select Define Sets.

11/19/04

56



2004 HEALTH CARE SURVEY OF DOD BENEFICIARIES — QUARTER I

alnisl
N e T e N R
Lﬁl_&lﬂﬂlﬂﬂﬂmﬁ
s | gl | e ]
1A || T e | e
L) i Py i [(EF T
e |!||: - i | Clar 1] T R
TR M -3} TS
il ] 1m0 it e L] [l
T @] — m EF
T m| m [RF- il
D LeEY 1] i W G
4 £} T 1] B T TR
T- 1 TTATE (e 1 Wi (iR T
s i 1m0 o | (vl T
Foonlh 1m| 1m| JCLF Ol
Tirn am| ] | IGE ol
danas | am| m| CEF. Cl
| RN W T
o] LE. 1 a1l [T
i k1] bl B [riche - g W
m am| . : TN
s | am| FRIIE|ID [ rm| mm| |3
anam | 3| e TT [ ] M| [iF ClE
;j '| FE 1] :"lll;ll:;l,ll 1 e O
T Win [ V| 1] 7] T
[T --Eru LT o
T Rk 6 I

o —— | e et e e

Insert a name for the subset of variables in the slot labeled Set Name. Move the variables you want to
subset from the list on the left to the slot marked Variables in Set. By way of illustration, we will move
the nine variables selected for the day’s processing.

The screen should look like the following:
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Click on Add Set to save the set specifications. The screen will change to the following:
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The set is now available for use. To use the set, Close the dialog box, reopen the Utilities menu,
choose Use Sets..., and receive this screen:
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Move HLTHCARE from the left slot to the right slot, which is labeled Sets in Use. Transfer
ALLVARIABLES from the right to the left slot. Leave NEWVARIABLES where it is. OK saves this
change.
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Until you change this specification, only nine original variables and any new variables will appear in the
dialog boxes associated with procedures.

Limiting the Number of Observations

There are many ways to limit the number of observations available to statistical reporting procedures.
The method illustrated here involves using filter variables with a menu-driven Filter By option. Using
filters deactivates but does not delete cases from the file. A diagonal line appears next to the filtered
cases in the Data Window.

The first task is to compute a filter variable for all the cases in the file.

A filter variable has two values: 0 and 1. The 1 indicates that the case will be included for procedures.
The 0 flags the case for removal.

For example, suppose you want to produce a table for people who live in the Southeast, i.e., cases for
which the variable xregion = 3. You would build a filter variable named filtr_3, which has the value 1
associated with the cases in the Southeast and O for all the other cases in the file. The logic is: if
xregion = 3, then filtr_3 =1, else filtr_3 =0.

The screen below shows the final step in computing the filter variable. The variable was first initialized
to 0. Then, the “If” condition was built for setting the filter variable to 1. You are now working with a
subset of variables, allowing the dialog boxes to be used more efficiently.
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The screen that follows shows the syntax that was generated as you built the variable filtr_3.
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Once you build the filter variable, you can apply it for analyzing only those people from the Southeast.

Using the Data menu, choose Select Cases.
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